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1

Welcome 

The purpose of this guide is to help you manage year end activities with DacEasy 
software. Depending on what DacEasy modules you use, you may need to do the 
following:

• Payroll Year End Procedures—This may include printing annual 
earnings and tax reports, printing employee W-2 and contract labor 1099 
forms, producing magnetic media, and closing the payroll year. For more 
information, refer to Chapter 2, “Payroll Year End Procedures.” 

• Accounting Year End Procedures—This may include closing the periods, 
forecasting budget figures, making year end adjustments, printing annual 
reports, closing the fiscal year, and purging data files. For more 
information, refer to Chapter 3, “Accounting Year End Procedures.” 

• Order Entry Year End Procedures—This may include closing the year, 
printing annual reports, and purging data files. For more information, 
refer to Chapter 4, “Order Entry Year End Procedures.” 

• Point of Sale Year End Procedures—This may include closing the year, 
printing annual reports, and purging data files. For more information, 
refer to Chapter 5, “Point of Sale Year End Procedures.” 

The DacEasy Business Center includes Workflow Guides that step you through 
the Period End and Year End processes. Each Workflow Guide includes a 
description of each step and a direct link to the feature. Refer to Chapter 6, 
“Working With Business Center Pages,” in the Getting Started Guide for more 
information on using Workflow Guides. 
1
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DacEasy Checks and Forms

You can save time and money with DacEasy’s complete line of checks and forms. 
All of our checks and forms are 100% compatible with DacEasy products so you 
can be sure checks and forms print correctly. Choose from a wide selection of 
colors, styles, and customized options—all at low prices. Plus, DacEasy provides a 
choice of four type styles and over 50 standard logos. You also have peace of mind 
because your checks and forms have the latest tamper-resistant features so you can 
use them with confidence.

Save Time and Money With Checks and Forms From DacEasy

• Payroll Checks

• Accounts Payable Checks

• Multi-Purpose Checks

• Self-Sealing Envelopes

• Tax Forms (1099, W-2, and W-3 forms)

Let DacEasy Print Your Invoices and Purchase Orders

• Product Invoice

• Service Invoice

• Statements

• Purchase Orders

• Order Entry Forms

• Point of Sale – Sales Receipts

• Credit Memos

Customize Your Forms for a Professional Image

• Custom Forms

• Pre-Inked Rubber Stamps

• Envelopes
2



Security
100% Satisfaction Guaranteed
Security

 DacEasy checks have the latest tamper-resistant features:

• Safety-Paper: Includes safety stain to indicate chemical tampering.

• Micro-Print Signature Line: Reads “MicroPrintSafe” and turns into a 
dashed line if reproduced.

• High-Resolution Border: Loses detail if copied.

• Padlock Icon: Directs readers to the back for Security checklist.

• Security Checklist: All security features listed on the back of each check.

• Security Screen: Back of each document displays a screen-back security 
seal.

100% Satisfaction Guaranteed

If for any reason you are not completely satisfied with your order, return your 
order for a full credit or refund. For more information on any of these products, 
refer to the DacEasy Forms catalog in your DacEasy product box or call (800) 222-
0505.

If you require technical assistance with any DacEasy product, take a moment to 
read about various Client Support options. All support plans are for 365 days from 
the date of activation or the time limit purchased, whichever comes first.

For more information on support plans, call (800) DAC-EASY or (800) 322-3279.

DacEasy Support Options

1-Hour $229.00

2-Hour $329.00 

Unlimited $379.00
3
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Preparing for a Technical Support Call

There are several things you should do before calling DacEasy.

• Register your DacEasy product, if you have not already done so.

• Read the section in the online Help that discusses the procedure you are 
performing.

• Attempt to duplicate the error in the Sample Company (Sample Data) 
provided with your software. 

To Prepare for a Technical Support Call

The DacEasy representative answering your call needs certain information to help 
you. To help the representative provide you with the best service, please do the 
following:

1 Be at your computer.

2 Have your manuals available.

3 Know the telephone number you have registered your product under or have 
your customer ID available.

4 Know the version number of your product. This can be found in the About 
section on the Help menu.

5 Write down the steps you performed prior to the problem occurring.

6 Write down the exact error message(s) as it appeared on your screen.

7 If you are operating on a network, you need to know the type of network, the 
location of the DacEasy program (program path), and the location of your 
DacEasy data (data path). 

8 If you are experiencing problems printing a report, form, or financial statement, 
you need to be able to provide the type of printer and possibly the printer driver 
you are using. 

For printing errors, consider printing to an alternate printer to help isolate the 
problem. Also, open the Sample Company and try printing the same report, form, 
or financial statement. This helps determine if the problem is specific to your 
company data.

Note
4



2

Payroll Year End Procedures 

This section explains how to run the DacEasy Payroll Year End routine, as well as 
print reports, forms, and worksheets that coincide with this routine. The following 
list gives the order in which you perform each routine. All payrolls for the current 
year must be posted prior to beginning these procedures. DacEasy allows you to 
make entries into the next year for up to a full quarter before you are required to 
perform Year End routine.
5



Payroll Year End Procedures
DacEasy Year End Guide
Year End Procedure Checklist

Check for online tax updates

Process and record any tax deposits

Reconcile checks

Purge checks

Print State Quarterly reports and worksheets

Print the Form 941

Print the Schedule B

Print the Form 940

Print the Form W-2s, Form W-3, and Form 1099s

Create Magnetic Media files

Create a backup of your company data for archival purposes

Close the month

Close the year (Close Year routine closes both the fourth quar-
ter and the year at the same time)

Purge the Detail History report (available in Version 10 or 
later)

Print W-4s
6



Checking for Tax Updates Online
To Set Up DacEasy Payroll to Automatically Check for Tax Updates
Checking for Tax Updates Online

The Online Tax Update feature allows you to periodically check the DacEasy Web 
site for the latest Payroll Tax Updates available for your program. For more 
information on this feature, contact the DacEasy Sales division at (800) DAC-
EASY or (800) 322-3279. 

To Set Up DacEasy Payroll to Automatically Check for Tax Updates

1 Select Online Tax Updates from the Periodic menu. The Online Tax Updates 
dialog box appears.

2 Type your Account ID.

3 Select how often you want to check for new Tax Update program files. Select 
Monthly or Quarterly if you want DacEasy to automatically check for new Tax 
Update program files. Select Do not check if you want to check for new Tax 
Update program files manually.

4 Click Save to save the changes.

To Check for Tax Updates Manually

1 Select Online Tax Updates from the Periodic menu. The Online Tax Updates 
dialog box appears.

2 Type your Account ID.

3 Click Check Now. The DacEasy Tax Update Service web page is minimized on 
the Windows Taskbar.

Note  Even if you have DacEasy set up to check for Tax Updates automatically, 
you can still use the Check Now button to manually check for new Tax Updates 
at any time.Note
7
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Making Tax Deposits

The Tax Deposit routine maintains a record of your tax liabilities, deposits, and 
the amount due for each of your taxes. Use this routine to print 940, 941, state, and 
local tax deposit checks. Refer to the DacEasy Payroll User’s Guide for more 
detailed information on recording tax deposits, 

Post all transactions before making tax deposits. The liability and deposit sections 
pull information from the Edit Employee Accumulations dialog box. Post all 
payroll transactions to ensure this information is current. To view or print the 
deposit history, click History (F7) while viewing the tax deposit.

To Make Tax Deposits

1 Select Tax Deposit from the Process menu, and then select the appropriate tax 
deposit module. You can record tax deposits for 940, 941, state, and local taxes. 
The appropriate dialog box appears.

2 Type the two-letter abbreviation of the state for which you want to make a 
deposit if you are recording a state tax deposit. 

Type the code of the local tax for which you are making a deposit if you are 
recording a local tax deposit. 

3 Select the quarter you want to make a deposit for using the Deposit For field. 

4 Complete the appropriate fields on the dialog box.

Click Help from the dialog box for a detailed description of each field. Click 
Address to record the address of the institution to whom the check is payable.

5 Click OK to save the tax deposit.

If you selected Computer as the Check Type, the Report Layout dialog box 
appears so you can print the tax deposit check. After printing the tax deposit 
check, the Report Layout dialog box appears so you can print the GL 
Transaction Summary report.

If you are using continuous-feed checks, click Test Page from the Report Layout 
dialog box to print a test check and verify the check is loaded properly. If you use 
this feature, the check number on the tax deposit dialog box is voided.

If you selected Manual or None as the Check Type, a message appears 
confirming you want to continue. Choose Yes to continue. The Report 
Layout dialog box appears so you can print the GL Transaction Summary 
report.

Note

Note
8



Making Tax Deposits
To Make Tax Deposits
6 Select the target and click OK to begin generating the report.

If you owe an amount for the prior quarter, a message appears. If you want to 
apply a portion of this deposit to the prior quarter, choose Yes. The deposit 
amount cannot be over the amount due for the prior quarter. If you choose 
No, DacEasy applies the deposit to the current quarter.
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Reconciling Checks

You can reconcile checks in DacEasy Payroll if you do not select the Erase Check 
Register After Posting or Reconcile With DacEasy Accounting check boxes on the 
System Preferences dialog box. 

Use the Reconcile Checks routine to keep track of outstanding, cleared, and 
voided payroll checks. A message appears if you try to view the Check Register but 
no checks are in the Check Register file. You can access this routine only if you 
printed checks or have posted manual checks in DacEasy Payroll.

When you access this routine, all checks appear in check number order along with 
the check date, employee code and name, and the amount of the check. The 
following steps explain how to use this routine to reconcile your payroll checks.

To Reconcile Checks

1 Select Reconciliation on the Periodic menu, and then select Reconcile 
Checks. The Check Reconciliation dialog box appears.

2 Select the check you need to mark as cleared or void, and choose the 
appropriate option in the Status column.

If you mark a check as cleared, Clear appears in the Status column. If you 
mark a check as void, the word VOID appears in the employee’s name, and 
Void appears in the Status column.

Once you change the status of a check to Void and save the Reconciliation, you 
cannot change the status of the check back to Cleared or Outstanding.

3 Repeat step 2 until all checks are marked appropriately.

Click Help from the Check Reconciliation dialog box for a detailed description 
of each field.

4 Click OK to update the Check Register. 

Note
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Purging Checks
To Purge Checks
Purging Checks

Depending on the number of checks you issue, you may want to purge checks in 
DacEasy Payroll once a month. Purging checks allows you to either delete voided 
and cleared checks or delete all checks. Run this routine at the end of the month 
to clear the file of excessive data buildup and to preserve hard disk storage space. 
The Purge Checks routine does not remove any posted data from the Employee 
file.

If you have sufficient hard disk space, you do not have to purge checks and can 
save all information in the Check Register file. By saving all the information, you 
can print quarterly, semi-annual, or annual Check Register reports during the 
year. 

Be sure to make a backup of your payroll data before you purge the detail in the 
Check Register file. You can restore this backup to review archived data.

To Purge Checks

1 Select Reconciliation on the Periodic menu, and then select Purge Checks. 
The Check Register Purge dialog box appears.

2 Click Backup. The File Backup/Restore dialog box appears. Make a backup of 
your payroll data. After the Backup routine is complete, the Check Register 
Purge dialog box appears again.

3 Select whether you want to purge only Cleared and Void checks or purge All 
checks prior to the date entered. 

If you need a record of the checks being purged from the Check Register file, print 
a Check Register report and make a backup of your payroll data before continuing 
with the Purge Checks routine.

4 Type the date prior to which the payroll checks should be deleted. The checks 
printed before the date entered are purged from the Check Register file.

5 Click OK to remove the checks from the Check Register file. 

Run the Recover routine on the Check Register file after you run the Purge Checks 
routine. The Recover routine compresses your files and frees up hard disk drive 
space. For more information on the Recover routine, refer to the Help topic titled 
“Using File Utilities.”

Note

Note

Note
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Printing State Quarterly Reports

DacEasy Payroll allows you print Form 9413 or 9414 State Quarterly Reports for 
state governmental reporting requirements. You can use these reports to submit 
State Unemployment Insurance (SUI) information. DacEasy also provides users 
with the State Quarterly Worksheet to simplify manual preparation of the State 
Quarterly Reports. 

The State Quarterly Worksheet includes calculations for the following items:

• Gross Wages (GrossWagesYTD)

• Wages Subject to SUI (Calculated GrossWagesQTD - all pretax and non-
taxed codes QTD from the Employee Accumulations)

• Excess Wages (Wages Subject to SUI - SUI limit)

• SUI Taxable Wages (Wages Subject to SUI - Excess Wages) 

• SUI Liability for all states (SUI WH QTD + SUI Liab QTD)

If you require additional information to file your report for a specific state, you 
can create a custom report in DacAccess. DacEasy’s Sample Company (Sample 
Data) provides helpful predefined reports. These reports can be copied to your 
company data files using the Shift+F3 command from the DacAccess Query or 
Publisher.

Print the State Quarterly reports after posting the last payroll for the quarter, but 
before closing the year. If you close the year before printing this report, you must 
restore a backup to recover the information. The State Quarterly Report routine 
prints the Form 9413 or 9414 on preprinted forms. If you want to complete the 
forms yourself, use the State Quarterly Worksheet routine to print the worksheet 
with the amounts necessary to complete the forms manually. Contact your state 
employment agency for information on where you can get the preprinted 9413 or 
9414 forms.

It is important to contact your state employment agency before printing a 
quarterly report, because different states have different requirements. Although 
you should be able to use this routine to submit a Form 9413 or 9414 in a majority 
of states, some states do not accept these forms.

Some states only accept Optical Character Reader (OCR) forms for their quarterly 
reports. DacEasy does not currently provide the ability to print OCR reports.

If you need to process a payroll for the next quarter before printing your state 
quarterly reports, be sure to enter the check date in the next quarter on the Pay 
Frequency dialog box. DacEasy stores this data in the Next Quarter column on the 
Edit Employee Accumulations dialog box.

Note
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Printing State Quarterly Reports
To Print a State Quarterly Report
To Print a State Quarterly Report

1 Select Quarter End from the Periodic menu, and then select State Quarterly 
Report. The State Quarterly Report dialog box appears.

2 Complete the fields on the dialog box.

3 Click OK to continue. The Report Layout dialog box appears.

4 Select the target and click OK to generate the forms.
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Printing State Quarterly Worksheets

Use the State Quarterly Worksheet as a source document for forms submitted to 
your state agencies as required by state governmental reporting requirements. 
Print the worksheet after posting the last payroll for the year, but before closing 
the year. If you close the year before printing this worksheet, you must restore a 
backup to recover the information.

It is important to contact your state employment agency to determine what type 
of quarterly form you must provide; different states have different requirements. 
Acquire the appropriate state forms before running this routine. Print the State 
Quarterly Worksheet to help you complete these forms.

Some states only accept Optical Character Reader (OCR) forms for their quarterly 
reports. DacEasy does not currently provide the ability to print OCR reports.

If you need to process a payroll for the next quarter before printing your state 
quarterly worksheet, be sure to enter the check date in the next quarter on the Pay 
Frequency dialog box. DacEasy stores this data in the Next Quarter columns on 
the Edit Employee Accumulations dialog box. 

To Print a State Quarterly Worksheet

1 Select Quarter End on the Periodic menu, and then select State Quarterly 
Worksheet. The State Quarterly Worksheet dialog box appears.

2 Type the range of state codes you want included in the worksheet.

3 Click OK to continue. The Report Layout dialog box appears.

4 Select the target and click OK to generate the worksheet.

Note
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To Print the 941
Printing the Form 941

This routine prints the federal tax return you must submit to the IRS at the end of 
every quarter. You need to print the 941 before closing the year. If you close the 
year before printing this form, restore the backup made just prior to closing the 
year to recover the information.

Each time you run the Posting routine, DacEasy updates the 941 file with all the 
information necessary to print out the ROFT (Record of Federal Tax liability) 
Section of the form. The top section of the 941 prints based on information stored 
on the Edit Employee Accumulations dialog box. When viewing the 941 form, the 
information tracked by DacEasy appears, but you can edit these amounts. You can 
enter additional information including adjustments that DacEasy does not track.

If you need to process a payroll for the next quarter before printing your Form 
941, be sure to enter the check date in the next quarter on the Pay Frequency 
dialog box. DacEasy stores this data in the Next Quarter columns on the Edit 
Employee Accumulations dialog box.

To Print the 941

1 Select Quarter End from the Periodic menu, and then select Form 941. The 
Form 941 dialog box appears.

2 Select whether you want to print the Federal Form or the Worksheet.

3 Type a name in the Name field if it is different from the trade name.

The information on the form automatically appears, pulling the information 
from the Edit Company dialog box and the employee records.

4 Make changes to the amounts on the form if necessary. 

5 Select whether you are a Semi-weekly or Monthly depositor.

6 Select OK to continue. The Report Layout dialog box appears.

If you select Federal Form as the Type, you have the option to print the form on 
plain paper. To print the form on plain paper, select the Plain Paper check box on 
the Report Layout dialog box. If you are printing the form on a preprinted form, 
do not select the Plain Paper option.

7 Select the target and click OK to generate the form.

If you are printing on continuous-feed preprinted forms, click Test Page (F8) 
from the Report Layout dialog box to print a test form and verify that the form 
is loaded properly.

Note
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Troubleshooting Printing the Form 941

DacEasy Payroll uses Adobe Acrobat Reader Version 6.0 or higher to print the 941 
Federal Form by opening Adobe Acrobat and completing the form with the 941 
information. You will notice when printing the Form 941, Schedule B, and W-4 
forms that the Adobe Acrobat splash screen appears when generating the report.

To correct problems printing the Form 941:

1 Try accessing Adobe Acrobat Reader. With Adobe Acrobat still open, try to print 
the Form 941 from DacEasy.

2 Try to print a Schedule B or W-4 form. If it does not print the 941 Schedule B or 
W-4, proceed to step 3. 

3 Try uninstalling and reinstalling DacEasy Payroll and/or Adobe Acrobat Reader 
Version 6.0 or higher. It can be found on the latest tax update CD at Browse 
Contents > Utility > Adobe.

Try the following in Acrobat Reader:

• Open Adobe Acrobat Reader. When the License Agreement prompt 
appears, be sure to select Accept to accept the terms of the agreement.

• Confirm that the version is 6.0 or higher. To check the version, select 
About Acrobat Reader from the Help menu.

• Confirm that the Forms Plug-ins are available. To check this, select About 
Adobe Acrobat Plug-ins from the Help menu. The About Adobe Acrobat 
Plug-ins dialog box appears. Select Forms and confirm it is loaded.

• Try printing a PDF file directly from Adobe Acrobat. If you do not have a 
PDF file available, select Reader Help from the Help menu to view the 
Acrobat Reader Online Help, which is a PDF file. Try printing a page 
from the Online Help.

• Confirm that only one version of Adobe Acrobat Reader is installed. You 
can do this from the Add/Remove Programs option in the Windows 
Control Panel. Remove any old version.

4 Open Windows Explorer and clear the TEMP folder and try to print the Form 
941 in DacEasy Payroll again. The TEMP folder is usually located in the Windows 
folder for most operating systems. If you are using a Windows NT operating 
system like Windows 2000, the TEMP folder is located in the WinNT folder.

5 If the Form 941 still does not print and/or you receive the error messages: 
“Printer already printing a report,” or “Printer in use by…”, try the following 
listed below.

Make sure you have your Windows operating system disk or printer drivers 
available before you delete the print driver.!

Warning
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Troubleshooting Printing the Form 941
• Delete the default printer driver from the Windows operating system.

• Add a new driver for the printer in Windows.

• Delete the DacEasy Payroll REPSETUP.DB file. This file is located in the 
Dep4base subfolder of your DacEasy Payroll installation folder. The 
default Installation folder for DacEasy Payroll is C:\DacEasy\PY. The 
REPSETUP.DB file is recreated once you access DacEasy Payroll.

• Try printing the Form 941 again. If the form still does not print, contact 
DacEasy Customer Support Services for assistance.

Troubleshooting Line 2 —Total Wages on the Form 941

DacEasy Payroll reports Federal Taxable Wages on Line 2 of the Form 941. 

DacEasy pulls this information from the Quarterly Accumulation column on the 
Earnings tab of the Edit Employee Accumulations dialog box. 

The following are some common reasons why your Line 2 on the Form 941 is 
incorrect: 

• You are looking at the wrong wages. Federal Wages QTD not Gross 
Wages QTD are reported on Line 2.

• You have not posted the last payroll of the quarter.

• You have edited the Employee file and now the total earnings on the 
Payroll Registers do not match the wages on Line 2. For example, you 
made edits directly to an employee on the Edit Employee Accumulations 
dialog box.

• You have restored a backup and one or more payrolls are missing from 
the backup.

• You have entered incorrect beginning balances in the Employee file.

• There was a partial posting and now the earnings on the Payroll Registers 
do not match Line 2.

Troubleshooting Line 7a—Calculation Vs Actual on the Form 941

Line 7a of the Form 941 normally contains a number derived from rounding. This 
number is the difference between what was actually withheld from the employee’s 
wages versus the amount of employee wages multiplied by the FICA percentages.
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To help locate the cause of an incorrect amount in Line 7a, a custom report was 
created in DacEasy Payroll. This report is available in the Sample Company 
(Sample Data) and is titled 941_Recap. To copy this report to your company, 
follow these steps. Open the Sample Company in DacEasy Payroll, and select 
Publisher from the DacAccess menu. Type 941_Recap and press Enter. Continue 
to press Enter until the report appears in the Report Editor. Select Options, and 
then select Copy Report. The Report Copy dialog box appears. Select to copy the 
report to another company and type the path to your company data files. Give the 
report a new report and query name. Select OK to copy the report. Now you can 
print the report from your company to help locate the reason Line 7a is incorrect. 
You also have the option to create your own custom report in DacAccess to gather 
information regarding Line 7a of the Form 941.

You may not have installed the Sample Data during installation. If so, reinstall 
DacEasy Payroll and include the Payroll Sample Data and copy the reports to your 
company files. 

The following are some common reasons why your Line 7a (Form 941) is 
incorrect: 

• Earnings were entered on the Transaction Entry dialog box, but the 
Calculate Payroll routine was not performed for the payroll prior to 
posting.

• Changes were made on the Transaction Entry dialog box after taxes had 
been calculated. 

• A reversed posting was done incorrectly (for example, deductions or 
liabilities were not included).

• An “after the fact” payroll was entered, but liabilities were not included 
on the Transaction Entry dialog box.

• The Employee file was manually edited or had a partial posting.

ROFT Date Sensitivity

The ROFT section of the Form 941 pulls from the MISC.DB file. This file is 
updated during the Posting routine according to the check date on the payroll 
transaction. If the liability amount for one month is understated and another 
month is overstated, Line 15 of the Form 941 is updated according to the check 
date (for example, employees worked 10/17/06 through 10/31/06 but the check 
date was 11/1/06). Line 15 would include this payroll in the total for the second 
(November) month, instead of in the total for the first (October) month.

The following are some common reasons why your ROFT section is incorrect: 

• The MISC.DB file was replaced during the quarter.

• A payroll was posted with an incorrect check date.

Note
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Troubleshooting Printing the Form 941
• The current payroll has not been posted.

• The year or quarter has been closed prior to printing the Form 941 or the 
Schedule B.

• You started using DacEasy Payroll mid-quarter and manually edited the 
Employee file to record existing accumulations for your employees.
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Printing the Schedule B

The Schedule B prints a report of your tax liability on a daily basis. The report 
shows a daily record of when tax liability was incurred. Like the ROFT, the 
Schedule B is updated according to the check date used on the payroll. You must 
complete this schedule if you are required to deposit on a semiweekly basis or if 
your tax liability on any day is $100,000 or more. You must show tax liability on 
this form, not deposits. The Schedule B, since its information is contained in the 
MISC file, is ONLY updated during the Posting routine. If you started using 
DacEasy Payroll in the middle of a quarter, the amounts are incorrect because 
manual entries were not posted to update the 941 file. Therefore, you must 
manually enter the amounts according to the day on the Schedule B form.

You need to print the Schedule B before closing the year. If you close the year 
before printing this form, restore the backup made just prior to closing the year to 
recover the information.

To Print the Schedule B

1 Select Quarter End from the Periodic menu, and then select Schedule B. The 
Print Schedule B dialog box appears.

2 Select whether you want to print the Federal Form or Worksheet.

3 Click OK to continue. The Report Layout dialog box appears.

If you select Federal Form as the Type, you have the option to print the form on 
plain paper. To print the form on plain paper, select the Plain Paper check box on 
the Report Layout dialog box. If you are printing the form on a preprinted form, 
do not select the Plain Paper option.

4 Select the target and click OK to generate the form.

Troubleshooting Printing the Schedule B

DacEasy Payroll uses Adobe Acrobat Reader Version 6.0 or higher to print the 
Schedule B Form by opening Adobe Acrobat and completing the form with the 
Schedule B information. You will notice when printing the Form 941, Schedule B, 
and W-4 forms the Adobe Acrobat splash screen appears when generating the 
report.

To correct problems printing the Schedule B or the Worksheet:

1 Try accessing Adobe Acrobat Reader. With Adobe Acrobat still open, try to print 
the Schedule B from DacEasy.

2 Try to print a 941 or W-4 form. If it does not print the 941 Schedule B or W-4, 
proceed to step 3. 

Note
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Troubleshooting Printing the Schedule B
3 Try uninstalling and reinstalling DacEasy Payroll and Adobe Acrobat Reader 
Version 6.0 or higher. It can be found on the latest tax update CD at Browse 
Contents > Utility > Adobe. 

Try the following in Acrobat Reader:

• Open Adobe Acrobat Reader. When the License Agreement prompt 
appears, be sure to select Accept to accept the terms of the agreement.

• Confirm the version is 6.0 or higher. To check the version, select About 
Acrobat Reader from the Help menu.

• Confirm the Forms Plug-ins are available. To check this, select About 
Adobe Acrobat Plug-ins from the Help menu. The About Adobe Acrobat 
Plug-ins dialog box appears. Select Forms and confirm it is loaded.

• Try printing a PDF file directly from Adobe Acrobat. If you do not have a 
PDF file available, select Reader Help from the Help menu to view the 
Acrobat Reader Online Help, which is a PDF file. Try printing a page 
from the Online Help.

• Confirm that only one version of Adobe Acrobat Reader is installed. You 
can do this from the Add/Remove Programs option in the Windows 
Control Panel. Remove any old version.

4 Open Windows Explorer and clear the TEMP folder and try to print the Schedule 
B in DacEasy Payroll again. The TEMP folder is usually located in the Windows 
folder for most operating systems. If you are using a Windows NT operating 
system like Windows 2000, the TEMP folder is located in the WinNT folder.

5 If the Schedule B still does not print and/or you receive the error messages: 
“Printer already printing a report,” or “Printer in use by…”, try the following 
listed below.

Make sure you have your Windows operating system disk or printer drivers 
available before you delete the print driver.

• Delete the default printer driver from the Windows operating system.

• Add a new driver for the printer in Windows.

• Delete the DacEasy Payroll REPSETUP.DB file. This file is located in the 
Dep4base subfolder of your DacEasy Payroll installation folder. The 
default Installation folder for DacEasy Payroll is C:\DacEasy\PY. The 
REPSETUP.DB file is recreated once you access DacEasy Payroll.

• Try printing the Schedule B again. If the form still does not print, contact 
DacEasy Customer Support Services for assistance.

!
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21



Payroll Year End Procedures
DacEasy Year End Guide
Printing the 940

This routine prints a Form 940. You can print either the form or a worksheet to 
help you complete your annual federal unemployment (FUTA) tax return, which 
you must submit to the IRS at the end of each year. DacEasy pulls information for 
the form from the Edit Employee Accumulations dialog box and the ROFT 
(Record of Federal Tax liability) in the 940 file, both of which DacEasy updates 
during the Posting routine. Because DacEasy clears the ROFT information during 
the Close Year routine, it is important to print out your Form 940 before you close 
the year. 

Information on State Unemployment Insurance (SUI) and FUTA wages, total 
payments, excess over limit, and FUTA tax for each quarter with a total for the year 
is available when printing the 940 worksheet. This information prints in the same 
format as the actual 940 form, but it also includes line detail as well as the dollar 
amounts.

To Print the 940

1 Select Year End from the Periodic menu, and then select 940-EZ. A message 
appears. Select OK to view the Form 940 dialog box.

2 Select whether you want to print the Federal Form or the Worksheet and type a 
name in the Name field if it is different from the default Name that appears. 
Type a Trade Name if is different from the Name. The information on the form 
appears, pulling the information from the Edit Company dialog box and the 
employee records.

3 Make changes to the amounts on the form if necessary.

4 Click OK. The Report Layout dialog box appears.

If you selected Federal Form as the Type, the Plain Paper check box is selected. 
This option prints the entire federal form with the corresponding amounts on plain 
paper.

5 Select the target and click OK to generate the form.

Note
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To Print W-2s
Printing W-2s

This option prints continuous-feed or laser W-2 forms in the format prescribed 
by the Internal Revenue Service. You can purchase these forms from the DacEasy 
Forms division by calling (800) 222-0505.

The federal government periodically changes the format of W-2 forms during the 
year. If you know the form has changed since your last upgrade or purchase of 
DacEasy Payroll, you need to get a Tax Update from DacEasy to print W-2 forms 
correctly. This Payroll Tax Update is available in December, allowing DacEasy to 
include all new tax laws. Contact the DacEasy Sales department at (800) DAC-
EASY for more information on the Payroll Tax Update.

You must print W-2 forms before you run the Close Year routine. If you perform 
the Year End routine before printing W-2 forms, you need to restore the backup 
made immediately prior to running the Year End routine to recover the 
information.

If you need to process a payroll for the next year before you print your W-2 forms, 
enter the dates for the next year on the Pay Frequency dialog box. If you process a 
payroll in the next quarter before you close the year, DacEasy stores this data in 
the Next Quarter columns on the Edit Employee Accumulations dialog box.

Employers who are filing magnetic media do not submit a Copy A form to the 
Social Security Administration and may use any of the W-2 form types. Therefore, 
any of the three W-2 Form options may be selected.

To Print W-2s

1 Select Year End from the Periodic menu, and then select W-2 Forms. The 
Print W-2 dialog box appears.

2 Select the type of W-2 form you are printing. 

Employers who are not filing magnetic media must submit a paper Copy A of 
Form W-2 with the Social Security Administration. Copy A is only available in 
the standard 2-Up format. To print this form, select 2-Up as the type of form you 
want to print. The 2-Up option allows you to print on continuous feed or laser 
forms. The 4-Up and 4-Up Horizontal options only print on laser forms.

3 Complete the remaining fields on the dialog box. Select the Custom Design 
check box if you need to customize your W-2s.

4 Click OK to save the information. The Report Layout dialog box appears. If you 
select the Custom Design check box, the Custom Design W2s dialog box 
appears. Complete the fields as necessary and click OK to continue.

Note
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5 Select the target and click OK to generate the forms. 

6 Follow the instructions on each screen to continue.

You can print a second set of W-2s, and a W-3 form after you print the first set of 
W-2s.

Troubleshooting Printing W-2s

This section provides tips when printing the W-2 forms. If you continue to 
experience problems printing your forms, contact Customer Support Services for 
assistance.

Avoiding Printer Jams When Printing W-2s

Continuous-feed W-2 forms come in four-, six- or eight-part forms. Some dot-
matrix printers jam or feed incorrectly while printing six-part forms because they 
can’t accommodate the thickness of these forms. Additionally, print heads on 
some printers don’t strike hard enough to reach all forms, rendering some parts 
unreadable.

If you have experienced any of these problems in the past, try carefully separating 
the six layers in half, leaving two separate sets of three-part forms. Dividing the 
forms in this manner produces a thinner stack of forms, which helps to prevent 
printer jams and increases the chance of the print head reaching through to the last 
form. Once the forms are divided, run the W-2 Forms routine twice, once for each 
set of forms. Be sure to use the same sort and rank options when printing each set 
of forms. You can print the W-2s an unlimited number of times before closing the 
year.

If you do not want to separate the W-2 forms manually, you can contact our 
Forms department at (800) 222-0505 to order Twin Sets, available in six- or eight-
part. These Twin Set forms are pre-split for you.

Reprinting After a Printer Jam 

If your W-2 forms jam in the printer while printing, you can use the sort and rank 
options to print a select range of W-2 forms. If you experience a jammed printer 
or a break in the continuous forms, you can reprint just the section of the forms 
that remains, rather than printing the whole batch again.

Note
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Including Local Taxes 3 & 4 on the W-2

Printing Local Table 3 and Local Table 4 tax information on the W-2 form 
requires setting up a separate customized W-2 for the employee or employees 
requiring the additional tax information. First, you use the sort and rank options 
to print W-2s for all employees who require Local 1 and 2 tax information on their 
W-2s. Then, you use the sort and rank options to print W-2s for all employees that 
require the Local 3 and 4 tax information. Follow the steps provided to customize 
the W-2 form to include Local Table 3 and Local Table 4 tax information.

To include Local Tax 3 and 4 on the W-2:

1 After printing all W-2s that require Local 1 and 2 tax information, return to the 
Print W-2 dialog box.

DacEasy automatically prints Local 1 and Local 2 tax information in boxes 18, 19 
and 20 on the W-2 form.

2 Select the range of employees that require Local Table 3 and Local Table 4. 

3 Select the Custom Design check box. 

4 Select OK to continue. The Custom Design dialog box appears.

5 Navigate to the line under Box 18 and click LookUp.

6 Select Local 3 Wages YTD and press Enter. The field appears in the selected 
field. Move to the second line and repeat this step for Local 4 Wages YTD. 

7 Navigate to the first line under Box 19 and click LookUp. 

8 Select Local 3 WH YTD and press Enter. The field appears in the selected field. 
Move to the second line and repeat this step for Local 4 WH YTD. 

9 Navigate to the first line under Box 20. Type the name for Local WH 3 and press 
Enter. Type the name for Local WH 4 in the second line under Box 20 and press 
Enter. 

10 Click OK to save the changes to the Custom Design dialog box. The Print W-2 
dialog box appears again.

11 Print the customized W-2s including the Local 3 and 4 tax information.

Note
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Printing the W-3

The W-3 form is a summary of the information printed on the W-2 forms for the 
employer. You can print the W-3 form automatically after you print the W-2 
forms. However, you can print just the W-3 form at any time. 

1 Select Year End from the Periodic menu, and then select W3 Forms. The Print 
W-3 dialog box appears.

2 Select whether or not you are reporting the W-3 information to more than one 
state.

If you selected to report to more than one state, proceed to step 4. 

3 Type the state abbreviation for the state for which you are filing the Form W-3 
and the corresponding State Tax ID. Click LookUp to select a state from a list.

The State ID must be entered and saved on the Edit State Tax Table dialog box 
before the state appears in the LookUp.

4 Select the Filing Third-Party Sick Pay Recap Form check box if you pay third-
party sick pay and are filing Third Party Sick Pay Recap Forms W-2 and W-3. If 
you select this check box, “Third-Party Sick Pay Recap” prints in Box 13 of the 
W-3 form.

5 Click Contact. The Contact Information dialog box appears. Verify that the 
information is correct. Make any changes necessary. Click OK to save the 
changes and return to the Print W-3 dialog box.

6 Select OK. A message appears, asking you to insert the form and begin printing.

7 Select Continue to print the W-3 form. The Report Layout dialog box appears.

8 Select the target and click OK to print the W-3 form.

Note
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To Print 1099s
Printing 1099s

This routine prints laser or continuous-feed 1099 forms in the format prescribed 
by the Internal Revenue Service. You must purchase laser or continuous-feed 
forms for federal/state reporting before performing this routine. You can purchase 
these forms from the DacEasy Forms division by calling (800) 222-0505.

DacEasy prints out 1099 forms for contract labor employees based on the dollar 
limit you specify when printing the forms. You also have the option of printing 
subtotals. If you select this option, every 42nd 1099 form prints a subtotal of the 
previous forty-one 1099 forms printed.

You must print 1099 forms before you close the year. If you close the year before 
printing these forms, you must restore a backup made prior to closing the year to 
recover the information.

To Print 1099s

1 Select Year End from the Periodic menu, and then select Federal 1099. The 
Print 1099 dialog box appears.

2 Complete the fields on the dialog box as necessary.

Select the Custom Design check box if you need to customize your 1099s.

3 Click OK to save the information. The Report Layout dialog box appears.

If you select the Custom Design check box, the Custom Design 1099s dialog 
box appears. Complete the fields as necessary and click OK to continue.

4 Select the target and click OK to generate the forms. 

5 Follow the instructions on each screen to continue.

You can print a second set of 1099s after you print the first set. 

 
Troubleshooting 1099 Printing

This section provides tips when printing the 1099 forms. If you continue to 
experience problems printing your forms, contact Customer Support Services for 
assistance.

Note
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Reprinting After a Printer Jam 

If your 1099 forms jam in the printer during printing, you can use the sort and 
rank options to print the range of 1099 forms remaining. If you experience a 
jammed printer or a break in the continuous-feed forms, you can reprint just the 
section of the forms that remains rather than print the whole batch again.

If you selected the Print Subtotals check box on the Print 1099 dialog box, every 
42nd 1099 form prints a subtotal of the previous forty-one 1099 forms. If you need 
to reprint the subtotal after a printer jam, make sure you include the entire range 
from the last printed subtotal.

Note
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To Create a Magnetic Media File
Creating Magnetic Media Files

The federal government requires you to file W-2 forms in a magnetic media file if 
you employ more than 250 employees. You must register with the Social Security 
Administration to submit a magnetic media file. DacEasy prints W-2 forms to a 
disk file that meets the magnetic media file requirement set by the Social Security 
Administration.

In addition, DacEasy allows you to include your state records in the magnetic 
media file if specified. If you are required to file magnetically with your state, you 
can copy the same file to another floppy disk and send that file to your state’s 
taxing authority. Check with your state taxing authority to confirm that it accepts 
MMREF-1 format. 

The following steps explain how to create and copy the necessary files to a disk.

You must create the W-2 magnetic media file to a disk before you close the year. 
If you close the year before creating this file, you must restore a backup made prior 
to closing the year to recover the information.

To Create a Magnetic Media File

1 Select Year End from the Periodic menu, and then select W2 Magnetic 
Media. The Magnetic Media dialog box appears.

2 Complete the fields on the dialog box.

3 Click OK to continue. The Contact Information dialog box appears. Verify that 
the information is correct. The address information entered as Address 1 on the 
Edit Company dialog box is used as the Delivery Address when filing MMREF. 
The address information entered as Address 2 on Edit Company dialog box is 
used as the Location Address when filing MMREF. Make any changes necessary. 

4 Click OK to continue.  A message appears, confirming that you want to create 
the magnetic media file. Click Continue. 

The W-2 magnetic media file is created and stored in the path entered. The 
name of the file is W2REPORT. Copy the magnetic media file to a disk to send 
it to the Social Security Administration.

Accuwage Information

The following website, http://www.ssa.gov/employer/accuwage/index.html, was 
provided by the Social Security Administration to enable you to test your 
magnetic media file before submitting it. Use this web site to download the 
appropriate Accuwage software and use it to check for mistakes or missing 
information before submitting your magnetic media file to the the government.

Note
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Creating a Backup

With the Backup routine, you can back up your data to a disk, to your hard drive, 
or to a network drive. We recommend that you make frequent backups of your 
data. It is especially important to make a backup before performing certain 
irreversible functions such as posting or purging. For your convenience, you can 
make backups directly from a number of irreversible functions such as the 
Transaction Posting, Automatic Payroll Calculation, Close Month, Close Quarter, 
and Close Year routines. In addition, you can make a backup at any time by 
accessing the Backup function from the File menu.

You can back up or restore all data files in a company profile at one time using the 
DacEasy Business Center. Refer to Chapter 5, “Working With the Business 
Center” in the Getting Started Guide for more information.

To Create a Backup of Your Data Files

1 Select Backup/Restore on the File menu. The File Backup/Restore dialog box 
appears.

2 Select Backup in the Operation field.

3 Select Payroll to back up only payroll data files. Select Accounting to back up 
only your accounting data files. 

4 Type the path to the data files you want to back up in the Source field. DacEasy 
displays the path to the company data files currently open, but you can change 
the path if you want to back up files located elsewhere on your hard disk drive.

5 Type the path where you want to store the backup files in the Target field. If 
you are not sure of the path, click the Browse button to locate the drive and 
folder you want.

6 Click OK. A message appears, confirming that you want to make a backup. 
Select Yes to continue. During the routine, DacEasy prompts you to insert disks 
in the appropriate drive, if necessary.

Make a separate backup of your accounting data if you are running DacEasy 
Payroll interfaced with DacEasy Accounting.
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To Close the Month
Closing the Month

This routine clears and prepares all monthly fields on the Edit Employee 
Accumulations dialog box to receive transactions for the next month. You should 
run this routine prior to posting the first payroll of each month. If you have any 
custom reports that pull from the month column in the Employee file, those 
reports must be run before closing the month.

To Close the Month

1 Select Month End from the Periodic menu. The Close Month dialog box 
appears.

2 Click Backup. The File Backup/Restore dialog box appears. Make a backup of 
your payroll data. After the Backup routine is complete, the Close Month 
dialog box appears again.

3 Click OK to close the month. 
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Closing the Year

This routine clears and prepares all year-to-date accumulation fields on the Edit 
Employee Accumulations dialog box to accept accumulations for the next year. If 
you select the Purge History check box, you can also clear information from the 
Payroll History files during the Close Year routine. Print hard copies of the Payroll 
History files by printing the Detail Transaction History, Codes History, and Detail 
reports to archive before purging the information. Print all necessary quarterly 
and annual reports before running this routine. This includes the State Quarterly 
Report, 941, Schedule B, 940, W-2s, W-3, and 1099s. In addition, the Current 
Quarter field must be 4 on the Edit Company dialog box before you can close the 
year.

If you record and post payroll transactions for the next quarter while in the fourth 
quarter, DacEasy posts these transactions into the Next Quarter columns and 
transfers them to the Quarter and Year columns when you run the Close Year 
routine.

The following list explains the processes that take place when you close the year.

• Clears the Year columns on all tabs of the Edit Employee Accumulations 
dialog box.

• Clears the Quarter columns on all tabs of the Edit Employee 
Accumulations dialog box.

• Moves the Next Qtr columns on all tabs of the Edit Employee 
Accumulations dialog box to the Current Quarter and Current Year 
columns.

• Updates the Current Quarter field to 1 and the Current Year field to 2006 
in the Edit Company dialog box. This information is stored in the 
DEPGNRL.DB file.

• Clears the MISC.DB file, which stores various tax information for the 
Form 941, Schedule B, and 940.

• Nets or clears vacation and sick time on the Edit Employee Information 
dialog box (if specified).

• Deletes terminated employees (if specified).

Be sure to make a backup of your payroll data before closing the year. This is 
important because you cannot access a previous year once the year is closed. You 
also want to make a backup if you need to retrieve any yearly accumulations after 
running the Close Year routine, especially if you select to purge history.

Note
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To Close the Year
To Close the Year

1 Select Year End from the Periodic menu, and then select Close Year. The 
Close Year dialog box appears.

You are only able to run the Close Year routine if you are currently in the fourth 
quarter. The current quarter appears in the DacEasy Payroll status bar. You can 
also view the current quarter on the Edit Company dialog box by selecting 
Company on the Edit menu.

2 Make any necessary selections on the dialog box.

3 Select the Purge History check box if you want to clear information from the 
Payroll History files. If you select this option, type the date range or type the 
date through which you want to purge information.

4 Click OK to close the year.

If you close the year while tax liabilities exceed deposits for the most recent 
quarter, the program displays the message “There is a tax liability balance due...” 
Select Abort to exit the routine and process the Tax Deposit, or select Continue to 
ignore the message and close the year. For more information on processing Tax 
Deposits, refer to the section titled “Making Tax Deposits” earlier in this chapter.

Purging the Detail Report 

You can purge the Payroll Transaction History files used for the Detail Report and 
Transaction History Report during the Close Year routine. When you select the 
Purge History check box during the Close Year routine, you are purging the 
information used for the Detail Report and the Transaction History Report. For 
more information on purging the Payroll Transaction History files, refer to the 
section titled “Closing the Year” earlier in this chapter.

Be sure to make a backup of your payroll data before you purge the Detail 
Report. You can restore this backup to review archived data.

Note

Note

Note
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Printing W-4s

DacEasy allows you to print the W-4 Federal Form. If any employees require any 
changes to this form, you can print a new form each year so you can keep a current 
W-4 form for all employees. Use this feature to print the federal form with your 
employee’s information. If you need to print additional information on the W-4 
form, refer to the section titled “Printing the New Hire Report” in the chapter 
titled “Management Reporting” in the DacEasy Payroll User’s Guide.

To Print the W4s

1 Select W4 Forms from the Periodic menu. The Form W-4 dialog box appears.

2 Type the Sort By range in the From and To fields.

3 Select how you want the report ranked and type the range in the From and To 
fields.

4 Click OK to save the information. The Report Layout dialog box appears.

If you want to print the W-4 Federal Form on plain paper, select the Plain Paper 
check box on the Printer tab of the Report Layout dialog box. If you are printing 
on a preprinted form, do not select the Plain Paper check box.

5 Select the target and click OK to generate the report.

Note
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Accounting Year End Procedures

This chapter includes information on closing periods and the year in DacEasy 
Accounting, as well as printing the necessary reports and forms that coincide with 
these routines. You are not required to close any General Ledger periods until you 
close the year. You can track up to two years of transactions in DacEasy 
Accounting before you are required to close the year. The following list provides 
the order in which you perform each routine. All transactions for the current year 
must be posted prior to beginning these procedures.

If you are running DacEasy Accounting interfaced with another DacEasy add-on 
module such as DacEasy Point of Sale, DacEasy Order Entry, or DacEasy Payroll, 
be sure all transactions within the year you are closing are posted in the 
appropriate module before you perform the Period End and Year End routines in 
DacEasy Accounting.

There are four different year-end routines in DacEasy: Accounts Receivable, 
Accounts Payable, Inventory, and General Ledger. Here are some rules of thumb 
to follow when closing the year:

• Run the Period End routines first.

• Run all year-end routines consecutively (for example, do not run 
Inventory Year End, and then wait a week to run the Payables Year End).

• Run the General Ledger Year End last.

The following checklist helps you plan your end-of-year tasks. While not all items 
on the list may apply to you, it is a general to-do list to help remind you to keep 
data files in order.

Note
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Year End Procedure Checklist

Complete each step on the Period End Checklist. Refer to the 
section titled “Closing Periods” for more information on these 
steps. Close all periods before running the Year End procedure. 
If you have any year-end adjustments, enter those before clos-
ing the last period.

The Accounts Receivable and Accounts Payable Period End routines are optional. 
Refer to the appropriate section in this chapter to determine if running these 
routines is right for you.

If you are using the Forecasting feature, print the Statistical 
YTD Report, perform the Forecast Calculation routine, and 
print the Forecast Report for receivables, payables, and inven-
tory to view your forecasted figures.

Print any financial reports you may need (for example, Trial 
Balance, Income Statement, Balance Sheet, and General Led-
ger Activity Report).

Print 1099 forms for contract labor vendors.

Make a backup of your data files.

Run Year End for the Receivables Ledger, Payables Ledger, 
Inventory modules.

Run Year End for the General Ledger.

Purge your data files for the prior year (This step is optional).

Run File Utilities on all data files if you purged any data.

Note
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Period End Checklist
Closing Periods

The following checklist details each step involved in closing the period for the 
Receivables Ledger, Payables Ledger, Inventory, and General Ledger modules.

The Period End routines are optional. Refer to the appropriate section in this 
chapter to determine if performing the Period End routine is right for you.

Period End Checklist

Post all modules for the period you are closing.

Back up data files. 

Generate finance charges for customers.

Print customer statements.

Run the Receivables Ledger Period End routine.

Run the Payables Ledger Period End routine.

Run the General Ledger Period End routine.

Run File Utilities on all files. 

Note
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Generating Finance Charges

You should generate finance charges just prior to performing the Receivable 
Ledger Period End routine. This is to accommodate your balance forward-type 
customers, because the open invoice detail for balance forward customers is 
consolidated into one open invoice during period end.

DacEasy calculates finance charges based on the finance charge rate entered on the 
customer record and the number of past due days on a customer’s invoice.

DacEasy creates a separate finance charge entry in the Accounts Receivable Open 
Invoice Detail file for each past due invoice and updates the Accounts Receivable 
Open Invoice Header file with the change. Finance charges print as separate items 
on the Accounts Receivable Aging Report and Statements. In addition, DacEasy 
ages finance charges along with the past due invoice.

The finance rate formula prorates charges on a 30-day cycle. For example, if an 
invoice is more than 30 days past due, DacEasy assesses the full percentage of the 
finance charge. If an invoice is 10 days past due, DacEasy uses the following 
formula to determine the finance charge: past due amount * (10/30 * finance 
charge %).

After calculating finance charges, DacEasy creates a summary transaction in the 
General Ledger. The journal code for the transaction is AR. As DacEasy generates 
finance charges, it prints a Finance Charge Journal. This journal provides the audit 
trail necessary to verify all entries made in the General Ledger and Customer files.

To Generate Finance Charges

1 Select Receivables from the Periodic menu, and then select Generate 
Finance Charges. The Generate Finance Charges dialog box appears.

It is important that you make a backup because you cannot reverse this routine 
after it has been performed. You can back up all data files for the company, 
including add-on modules, from the Business Center. Or, to access the 
Accounting Backup routine, click Backup from the Generate Finance Charges 
dialog box.

2 Type the date used to determine which invoices are past due and the amount of 
the finance charge. 

Finance charges are prorated based on a 30-day period. If an invoice is more 
than 30 days past due, it is assessed the full finance charge. If an invoice is 10 
days past due, it is multiplied by a prorated percentage (10/30 * finance charge 
%) to calculate the finance charge amount.

Note
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Printing Customer Statements
3 Select OK to generate finance charges for all customers. A Finance Charge 
Journal prints, and a summary transaction is posted to the General Ledger with 
an AR journal code.

To generate finance charges for a range of customers, select Range and type the 
range of customer codes. To generate finance charges for customers that do not 
fall within a sequential range, choose Select as the Scope. When you click OK, 
you can select the customers for whom you want to generate finance charges.

Printing Customer Statements

DacEasy allows you to print statements for your customers. You can customize the 
statements for printing on plain paper or on preprinted forms. For more 
information on printing customer statements, refer to the Online Help topic titled 
“Printing statements.”
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Closing the Period for the Receivables Ledger

The Receivable Ledger Period End routine does the following:

• Removes all paid-in-full invoices from the Accounts Receivable Open 
Invoice Header and Detail files. Removes all the paid-in-full invoices 
from the Accounts Receivable Open Invoice file in all prior versions. This 
information appears on the Aging Report and Statements. The invoice 
and payments must be posted and be dated on or before the date the 
Period End routine is run.

• Updates the Balance Information for your customers. This Period is 
cleared and the amount is added to the Beginning field.

• Consolidates all remaining posted transactions for the period into one 
invoice for balance forward-type customers. The date becomes the 
invoice number using the YYYYMMDD format.

• Updates the Accounts Receivable Open Invoice Header file. The 
Accounts Receivable Open Invoice file is used for the Credit Check and 
Alert features.

You should generate finance charges prior to running the Accounts Receivable 
Period End routine. This is to accommodate your balance forward-type 
customers, because the open invoice detail for balance forward customers is 
consolidated into one open invoice during period end.

• The Accounts Receivable Period End routine does not prevent you from 
entering customer transactions for the period you close.

To Run the Period End Routine for Receivables

1 Select Receivables from the Periodic menu, and then select Period End. The 
Accounts Receivable Period End dialog box appears. 

It is important that you make a backup because you cannot reverse this routine 
after it has been performed. You can back up all data files for the company, 
including add-on modules, from the Business Center. 

2 Type a date corresponding to the period you want to close. The corresponding 
period appears below the date. Note: you may close more than one period at a 
time.

3 Click OK to close the period for the Receivables Ledger. A confirmation 
message appears when the process is complete. 

4 Select Continue to return to the main menu.

Note

Note
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To Run the Period End Routine for Payables
Closing the Period for the Payables Ledger

The Payables Ledger Period End routine does the following:

• Removes all paid-in-full invoices from the Accounts Payable Open 
Invoice Header and Detail files. Removes all paid-in-full invoices from 
the Accounts Payable Open Invoice file in all prior versions. This 
information appears on the Aging Report, Statements and Payments 
Report. The invoice and all payments must be posted and be dated on or 
before the date the Period End routine is run.

• Updates the Balance Information area on each vendor record. This 
Period is cleared, and the amount is added to the Beginning field.

• Consolidates all remaining posted transactions for the period into one 
invoice for balance forward-type vendors. The date becomes the invoice 
number using the YYYYMMDD format.

• Updates the Accounts Payable Open Invoice Header file. This file is used 
for the Payables Reminder and Alerts feature.

The Payable Ledger Period End routine does not prevent you from entering 
Payables Ledger transactions for the period you close.

To Run the Period End Routine for Payables

1 Select Payables from the Periodic menu, and then select Period End. The 
Accounts Payable Period End dialog box appears.

It is important that you make a backup because you cannot reverse this routine 
after it has been performed. You can back up all data files for the company, 
including add-on modules, from the Business Center. 

2 Type a date corresponding to the period you want to close. The period appears 
below the date. Note: you may close more than one period at a time.

3 Click OK to close the period for Accounts Payable. A confirmation message 
appears when the process is complete. 

4 Select Continue to return to the main menu.

Note

Note
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Entering Account Budget Figures

You can enter budget figures for your chart of accounts, and then view the 
information on financial reports and listings. You can only enter budget amounts 
for detail accounts. DacEasy automatically passes the budget amount entered for 
each detail account to the parent (general) accounts above it.

You can enter budget figures for your accounts using two different methods. Enter 
budget figures for one account at a time from the Account History dialog box, or 
enter budget figures for all accounts at the same time using the Budget routine on 
the Periodic menu. Refer to the Online Help for more information on the 
Account History dialog box. The steps required to enter budget figures from the 
Budget routine on the Periodic menu follow.

To Enter Budget Figures

1 Select General Ledger from the Periodic menu, and then select Budget. The 
LookUp Account Budget window appears.

2 Double-click a detail account and the Account Budget dialog box appears.

You can view budget figures for general accounts; however, you cannot edit 
general accounts. Each detail account updates the general accounts into which it 
flows.

3 Type the Budget amounts in the appropriate periods. You can click Duplicate to 
repeat the amount for each remaining period. 

4 Click OK to update the account budget information.

Note
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To Run the Period End Routine for the General Ledger
Closing the General Ledger Period

The General Ledger Period End routine changes the status on the periods table to 
Closed for the selected period and all prior periods. You cannot make entries into 
a closed period, and a closed period cannot be changed to an open or active status. 
You do not have to close the period prior to entering transactions in the next 
period. The only time you are required to close the period is prior to closing the 
year.

You can close an accounting period after you (1) enter and post all accounting 
activity for a given period and (2) print all associated reports, journals, and 
financial reports. Use discretion when you close a period; once you close a period 
in the General Ledger, you cannot enter a transaction for dates within or before 
the closed period.

Closing a period closes all periods prior to the selected period, in addition to the 
selected period.

To Run the Period End Routine for the General Ledger

1 Select General Ledger from the Periodic menu, and then select Period End. 
The General Ledger Period End dialog box appears.

It is important that you make a backup because you cannot reverse this routine 
after it has been performed. You can back up all data files for the company, 
including add-on modules, from the Business Center. 

2 Type a date corresponding to the period you want to close. The corresponding 
period appears below the date.

3 Select OK. If prior periods are not closed, a message appears, warning that you 
are closing more than one period. Select Yes to close the current period and all 
prior periods. A confirmation message appears when the process is complete.

If unposted transactions exist, an error appears. You must post the specified 
module before closing the period.

4 Select Continue to return to the main menu.

Troubleshooting the General Ledger Period End Routine

This section offers some tips for working through common error messages you 
may receive while performing the General Ledger Period End routine.

Note

Note
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Errors Due to Unposted Transactions

When attempting to close periods in the General Ledger, you may experience a 
number of errors stating “Transactions have not been posted.” The error tells you 
which module has the unposted transactions. It, however, does not tell you which 
period is unposted. Here are some steps to help locate the unposted transactions.

1 Select Period End from the General Ledger menu and close the first open 
period. If the program closes the period successfully, then you know the 
unposted transactions are in a different period. Continue this process for each 
subsequent period until you receive the error “Transactions have not been 
posted.” 

2 Post the unposted transactions, and then close the period. 

To determine whether there are unposted transactions for the period you are 
closing, select each module on the Journals menu and try to print a journal for the 
period you are closing. If you receive the message “Error #144 No Records found 
in Range entered,” all transactions are posted for that module for that period. If a 
journal prints, there are unposted transactions for the module for the selected 
period.

3 If you still receive the error and cannot find the unposted transaction, run File 
Utilities on all data files. For more information on the File Utilities routine, refer 
to the Help topic titled “Using File Utilities.”
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Closing the Year

There are four different year-end routines in DacEasy: Accounts Receivable, 
Accounts Payable, Inventory, and General Ledger. There are two rules of thumb 
when closing the year:

• Run all year-end routines consecutively (for example, do not run 
Inventory Year End, and then wait a week to run Payables Year End).

• Run the General Ledger Year End last.

The following checklist helps you plan your end-of-year tasks. While not all items 
on the list may apply to you, it is a general to-do list to help remind you to keep 
data files in order.

If you are running DacEasy Accounting interfaced with another DacEasy add-on 
module such as DacEasy Point of Sale, DacEasy Order Entry, or DacEasy Payroll, 
be sure all transactions within the year you are closing are posted in the 
appropriate module before you perform the Period End and Year End routines in 
DacEasy Accounting.

Year End Checklist

If you are using the Forecasting feature, print the Statistical 
YTD Report and perform the Forecast Calculation for receiv-
ables, payables, and inventory.

If you performed the Forecast Calculation routine, print the 
Forecast Report for receivables, payables, and inventory to 
view your forecasted figures.

Print any financial reports you may need (for example, Trial 
Balance, Income Statement, Balance Sheet, and General Led-
ger Activity Report.)

Make a backup of your data files and label it Year End 2006.

Run Year End for Receivables.

Run Year End for Payables.

Run Year End for Inventory.

Run Year End for the General Ledger.

Purge your data files for the prior year (this task is optional).

Run File Utilities on all data files if you decided to purge infor-
mation.

Note
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Forecasting

You can plan for the next year by forecasting your purchasing figures for your 
vendors and sales figures for customers, products, and services. Before you run the 
Year End routine, run the Forecast Calculation routine to forecast these figures.

Perform the following tasks to use the Forecasting routine:

• Prior to running the Forecast Calculation routine, print the Statistical 
YTD Report to view forecasted figures for the current year and compare 
these numbers to actual figures.

• Run the Forecast routine prior to running the Year End routine. DacEasy 
places the forecast amounts in the Budget column on the Historical 
Information dialog box for each record. 

• Print the Forecast Report to view the past year figures with the budgeted 
figures for the New Year. 

To Print the Statistical YTD Report

1 Select Receivables, Payables, or Inventory from the Periodic menu, and 
then select Print Statistical YTD. The Print Statistical YTD dialog box 
appears.

2 Select the sorting method and type a range if you want to print the report for a 
range of records. If you do not enter a range, the default is First to Last.

3 Click OK and the Report Layout dialog box appears. 

4 Select the target, edit the layout if necessary, and then click OK to view the 
report.

Repeat these steps for each module (Receivables, Payables, or Inventory) for 
which you want to view a Statistical YTD report.

To Forecast Budget Figures

1 Select Receivables, Payables, or Inventory from the Periodic menu, and 
then select Forecast Calculation. The Forecast Calculation dialog box 
appears.

2 Select the method by which to calculate the forecast figures and complete the 
Percent field if the percent method is selected.

3 To calculate the forecast for a range of records, select a Sort By method and 
type a range. If you do not enter a range, the default is First to Last and the 
forecast is calculated for all records.

Note
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To Print the Forecast
4 Click OK to calculate the forecast.

Repeat these steps for each module (Receivables, Payables, or Inventory) to 
complete the Forecast Calculation routine.

To Print the Forecast

1 Select Receivables, Payables, or Inventory from the Periodic menu, and 
then select Print Forecast. The Print Forecast dialog box appears.

2 Select the method by which to sort the report. Type a range if you want to 
limit the records that appear on the report.

3 Click OK and the Report Layout dialog box appears. 

4 Select the target, edit the layout if necessary, and then click OK to view the 
report.

Repeat these steps for each module (Receivables, Payables, or Inventory) for 
which you want to view the Forecast report.

Note

Note
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Closing the Year for the Receivables Ledger

The Receivable Ledger Year End routine updates historical information for 
each customer. DacEasy transfers the year-to-date figures to last year and last 
year’s amounts to the year-before-last. You lose balances for the year-before-
last during this routine. To retain the information in the Year Before Last 
fields, make and store a backup of your data files for archival purposes.

If you are using the Forecasting feature, perform the Receivables Forecast-
ing routine prior to running the Receivables Ledger Year End.

To Run the Receivable Ledger Year End Routine

1 Select Receivables from the Periodic menu, and then select Year End. A 
message appears, warning you to make a backup before proceeding.

It is important that all transactions for the current year are posted prior to 
closing the year. Run the General Ledger Period End routine for the last 
period of the year to ensure that transactions are posted before the Receivable 
Ledger Year End routine is performed.

2 Click Start Year End Close to close the year. A confirmation message 
appears when the process is complete.

3 Select Continue to return to the main menu.

Note

Note
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To Print 1099 Forms
Printing 1099 Forms

DacEasy tracks the vendor information required to issue a 1099 at the end of 
the year. Select the Contract Labor check box on the Edit Vendor dialog box 
for each vendor that requires a 1099. This form shows the amount you paid 
to the vendor during the year. DacEasy gets this information from the Vendor 
Payment file. To view this information, click Options from the vendor record, 
and then select 1099 Information.

To Print 1099 Forms

1 Select Payables from the Reports menu, and then select 1099s. The 
1099s dialog box appears.

2 Complete each field. The federal and state tax IDs entered on the 
Company Information dialog box appear, as well as the current year. You 
can edit these fields if necessary. A 1099 prints for each contract vendor 
that received payments equal to or greater than the amount entered in the 
Minimum field. 

3 Click OK to access the Report Layout dialog box.

4 Select the target, edit the layout if necessary, and then click OK to begin 
printing. 

Troubleshooting the 1099 Routine

For a 1009 to print for any vendor 

• Contract Labor must be checked in Edit-Vendors on the Account 
tab by the beginning of the year.

• Cash transaction must have been made and posted to the Contract 
Labor vendor.

If the conditions above were not met and you must print a 1099, you may 
correct this situation using the following steps:

1 Open the vendor file, select Edit-Vendor, and then the Account tab.

2 Click Contract Labor.

3 Click Options and select 1099 Information.

4 Then, enter the Year to Date Payment Amount.
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Closing the Year for the Payables Ledger

The Payables Ledger Year End routine updates the historical information for 
each vendor. DacEasy transfers year-to-date values to last year and last year’s 
balances to the year-before-last. You lose balances for the year-before-last 
during this routine. To retain information in the Year Before Last fields, make 
and store a backup of your data files for archival purposes.

If you are using the Forecasting feature, perform the Payables Forecasting 
routine prior to running Payables Ledger Year End.

To Run the Payables Ledger Year End Routine

1 Select Payables from the Periodic menu, and then select Year End. A 
message appears, warning you to make a backup before proceeding.

It is important that all transactions for the current year are posted prior to 
closing the year. Run the General Ledger Period End routine for the last 
period of the year to ensure that transactions are posted before the Payables 
Ledger Year End routine is performed.

2 Click Start Year End Close to close the year. A confirmation message 
appears when the process is complete. 

3 Select Continue to return to the main menu.

Note

Note
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To Run the Inventory Year End Routine
Closing the Year for Inventory

The Inventory Year End routine updates historical information in the 
Product and Service files. DacEasy transfers year-to-date balances to last year 
and last year’s balances to year-before-last. You lose balances for the year-
before-last during this routine. To retain information in the Year Before Last 
fields, make and store a backup of your data files for archival purposes.

If you are using the Forecasting feature, perform the Inventory Forecasting 
routine before you run Inventory Year End.

To Run the Inventory Year End Routine

1 Select Inventory from the Periodic menu, and then select Year End. A 
message appears, warning you to make a backup before proceeding.

It is important that all transactions for the current year are posted prior to 
closing the year. Run the General Ledger Period End routine for the last 
period of the year to ensure that transactions are posted before the Inventory 
Year End routine is performed.

2 Click Start Year End Close to close the year. A confirmation message 
appears when the process is complete.

3 Select Continue to return to the main menu.

If you skip the inventory year end routine or run it more than once, the 
Product Activity report will be incorrect. 

Note

Note

Note
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Closing the Year for the General Ledger

When you run the General Ledger Year End routine, your data files are 
updated as follows:

• The Periods tab on the Company Information dialog box is updated 
to reflect the new year (Second Year periods become First Year 
periods and the following year is added to the Second Year). All 
transactions for the year must be recorded and posted before 
running the Year End routines. After you close the year, you cannot 
enter transactions for the year.

• The Account History dialog box for each account is updated to 
reflect the new periods structure. DacEasy transfers the This Year 
balance to the Last Year balance field for each period, providing you 
with historical information for the previous year. 

• The Salesperson History dialog box is updated to reflect the new 
periods structure.

• The Sales Tax History and Purchase Tax History dialog boxes are 
updated to reflect the new periods structure.

• Revenue and Expense accounts are zeroed out (beginning balances), 
and the net profit or loss is transferred to the Current Earnings 
account entered on the Account Interface dialog box. 

After you have run Year End for receivables, payables, and inventory, you are 
ready to close the General Ledger for the year.

Before you run the Year End routine, you must run the General Ledger Period 
End routine for the last month of the year.

To Run the General Ledger Year End Routine

1 Select General Ledger from the Periodic menu, and then select Year 
End. A message appears, warning you to make a backup before 
proceeding. 

2 Click Start Year End Close to close the year. A confirmation message 
appears when the process is complete.

If each period has not been closed, an error appears. Exit the Year End 
routine and run the General Ledger Period End routine to close the last 
period of the current year. Then, return to the Year End routine to 
continue closing the year.

Note
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Troubleshooting the General Ledger Year End Routine
If a Current Earnings account was not entered on the Account Interface 
dialog box, you are prompted to enter a clear to account. Type the 
current earnings account number or click LookUp and select the account 
from the list.

3 Select Continue to return to the main menu. 

After you run General Ledger Year End routine, the first transaction for the 
new year should be a transfer transaction. The transfer transaction moves the 
current earnings balance (for the year just closed) to a Retained Earnings 
account.

Troubleshooting the General Ledger Year End Routine

This section offers answers to some questions and tips for working through 
common error messages you may receive while performing the General 
Ledger Year End routine.

Error #265 Last Month Must be Closed

Before performing the General Ledger Year End routine, the last month of 
that year must be closed. This error occurs when the General Ledger Period 
End routine was not run for the last period on the Periods tab of the 
Company Information dialog box. Once the Period End routine is performed 
for the last period, a status of “C’ appears for all periods in the First Year 
column. Run the General Ledger Period End routine for the last month of the 
year, and then return to the Year End routine to close the year. 

Why Am I Prompted for a “Clear to Account”?

When you close the year, the Revenue and Expense accounts are zeroed out 
and the net profit or loss is transferred to the Current Earnings account (or 
the “Clear To” account) entered on the Account Interface dialog box. If this 
field is blank, the program prompts you for a “Clear To” account. The 
account normally used in the DacEasy sample chart of accounts is 33 Current 
Earnings; however, you can use any detail Capital account as the “Clear To” 
account. 
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Error #86 The Current Earnings Account is Not a Capital Account.

The Current Earnings account selected on the Account Interface dialog box 
or during Year End must be a Capital account. To verify the account type, 
select Accounts from the Edit menu, and then type the account number you 
are using as the Current Earnings or “Clear To” account. The Group selection 
must be Capital for the account selected as the Current Earnings or “Clear 
To” account.
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To Purge Files
Purging Data Files

Use the Purge routine to remove unwanted information from your data files. 
If you purge a transaction file, DacEasy removes all posted and deleted 
transactions from the file for the specified date range. In addition, you can 
purge customers, vendors, products, and services that you no longer need. 

After you purge your transaction files, you can no longer view your 
transactions or print listing reports to view these transactions. For this reason, 
you might choose not to purge data until after you close the year. 
Additionally, you may choose not to purge the General Ledger since it serves 
as your audit trail. It is very important that you back up your data files prior 
to purging information. Once the data has been purged, it can only be 
retrieved by restoring a backup made prior to running the Purge routine. 

To increase available hard disk space, run the Recover routine on the file after 
you run the Purge routine. For more information on the Recover routine, 
refer to the Help topic titled “Using File Utilities.”

To Purge Files

1 Select Purge from the Periodic menu. The Purge Files dialog box appears.

2 Select the file to purge.

3 If a transaction file is selected, type the range of transactions to purge 
based on the transaction date. All records up to and including the date 
entered are purged.

If a non-transaction file is selected, type the ending date for the last 
record to purge. All records up to and including the date entered are 
purged.

4 Click OK. A confirmation message appears when the Purge process is 
complete.

5 Select Continue to return to the Purge Files dialog box.
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Order Entry Year End Procedures

The Year End routine updates the historical information in your Customer, 
Product, Service, Salespeople, and Tax modules. DacEasy transfers the year-to-
date (YTD) values to the last year (LY) field and last year values to year before last 
(YBL). Values in the Year Before Last fields are removed during the Year End 
routine. The routine also changes the period dates to the new year.

Performing the Year End routine in DacEasy Order Entry is almost the same 
procedure as the Year End routine in DacEasy Accounting. If you are running 
DacEasy Order Entry interfaced with DacEasy Accounting, you are not required 
to run year end in Order Entry. 

As mentioned earlier, the information for the year before last is removed during 
the Year End routine. If you want to retain this historical information for your 
customers, products, and services, make a backup of your data files before 
performing the Year End routine. Store the backup for archival purposes.
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To Run the Year End Routine

If you are not running DacEasy Order Entry interfaced with DacEasy Accounting, 
the year end process updates the historical information for Customer, Product, 
Service, and Tax files. It updates the salesperson history by moving the first year 
Sales and Commission amounts to the second year. If you are interfaced with 
DacEasy Accounting, refer to the next section titled “To Run the Year End Routine 
When Interfaced With DacEasy Accounting.”

1 Download the WebStore orders that are using a date in the year you are closing. 
Post all invoices for the year you are closing. For steps on posting, refer to the 
chapter titled “Processing Orders” in the DacEasy Order Entry User’s Guide.

The easiest way to verify that all invoices are posted is to run a Sales Listing report 
in DacEasy Order Entry from first to last. Select Sales Journal from the Process 
menu. Select to print a Listing. If no asterisks appear next to the invoice or return 
number, all invoices or returns are posted.

2 Make a backup of your order entry data files. Clearly label each backup disk.

3 Select Year End from the Periodic menu. The current year appears. Verify that 
the year is the one you want to close. 

If the year you want to close does not correspond with the year that appears, 
exit the dialog box and change the program date. Then, return to the Year 
End dialog box.

If the year that appears is correct, select Yes to continue. Order Entry closes 
the year.

To Run the Year End Routine When Interfaced With DacEasy 
Accounting

Follow these steps to run the Year End routine if you are interfaced with DacEasy 
Accounting. If you are not interfaced with DacEasy Accounting, refer to the 
previous section titled “To Run the Year End Routine.”

1 Download the WebStore orders that are using a date in the year you are closing. 
Post all invoices for the year you are closing. For steps on posting, refer to the 
chapter titled “Processing Orders” in the DacEasy Order Entry User’s Guide.

The easiest way to verify that all invoices are posted is to run a Sales Listing report 
in DacEasy Accounting from first to last. Select Billing from the Journal menu. 
Select to print a Listing. If no asterisks appear besides the invoice or return 
number, all invoices or returns are posted.

Note

Note
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To Run the Year End Routine When Interfaced With DacEasy Accounting
2 Make a backup of your accounting data files, and then make a backup of your 
order entry data files. Clearly label each backup disk.

3 Select Year End from the Periodic menu. The current year appears. Verify that 
the year is the one you want to close. 

If the year you want to close does not correspond with the date that appears, 
exit the dialog box and change the program date. Then, return to the Year 
End dialog box.

If the year that appears is correct, select Yes to continue. DacEasy Order Entry 
closes the year.

4 Exit DacEasy Order Entry and access DacEasy Accounting. Refer to the chapter 
titled “Accounting Year End Procedures” for more information on performing 
the Year End routine in Accounting.

When you are interfaced with DacEasy Accounting, you are not required to run 
the Year End Routine in Order Entry. When Order Entry is interfaced with 
DacEasy Accounting, the Accounting Periods Table is referenced.

Note
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Purging Data Files

DacEasy Order Entry maintains information in various data files for the entire 
year. Even after you perform the Post Shipments routine, Order Entry retains the 
order information so you can print sales analysis reports and sales listings that 
include data for the entire year.

However, some of the files can become very large as a result of holding old data. 
DacEasy Order Entry provides an easy way to purge information from your data 
files. The Purge routine purges information from the files according to the date 
range specified. 

For example, assume you just closed the year and started processing orders for the 
next year. To remove all orders prior to the new year, use the Purge routine. To 
ensure that you remove all information from the previous year, you should 
perform the Purge routine for all data files using the dates from the previous year.

To increase available hard disk space, run the Recover routine on the file after you 
perform the Purge routine. 

File Descriptions

Here is a brief explanation of the data contained in each file. Review the list to 
determine which files you want to purge and which files include information you 
want to maintain for reporting purposes.

General Ledger This file contains all general ledger transactions 
created when DacEasy Order Entry is not interfaced 
with DacEasy Accounting. DacEasy Order Entry 
assigns its own account numbers to the transactions 
in the General Ledger files. To print a listing of 
general ledger transactions, select General Ledger 
from the Reports menu.

If you are running DacEasy Order Entry interfaced 
with DacEasy Accounting, Order Entry uses the 
General Ledger files in Accounting. To purge the 
information from these files, we recommend you 
purge the general ledger transactions in DacEasy 
Accounting.
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Sales Orders This file contains detail information for all orders 
entered in the program. Order Entry maintains the 
order detail in this file, even after you ship orders 
and post shipments. To obtain a printed copy of the
contents of this file, select Sales Orders from the 
Reports menu. Purging Sales Orders also purges the
Credit Card file. Only orders with a status of 
Completed, Voided, or Canceled are purged 
through the Purge routine.

Quotes This file contains the detail of all sales quotes in the
company. Use the Purge routine to delete old quotes
you do not need anymore. To print the contents of 
this file, select Print Orders from the Process menu,
and then select Quotes. 

Invoices This file contains all of the invoices created by the 
orders you have shipped. Do not confuse invoices 
with orders in the program. When you ship an order
or RMA (Returned Merchandise Authorization), 
Order Entry creates a new transaction called an 
invoice or sales return. This file is used for the 
AutoOrder and AutoReorder feature. If you would 
like to retain your customer’s sales history for this 
feature, do not purge this file.

If you are running DacEasy Order Entry interfaced 
with DacEasy Accounting, Order Entry creates 
invoices and sales returns in your invoice 
transaction files in DacEasy Accounting. You can 
purge invoices and sales returns using the Purge 
routine in either DacEasy Accounting or DacEasy 
Order Entry. To print the contents of this file before
purging, print the Sales Listing report in DacEasy 
Order Entry or the Billing Listing in DacEasy 
Accounting.

Serial Numbers DacEasy Order Entry tracks serial numbers for your
products and services after a sale. DacEasy stores 
serial number information in a separate file from the
orders so you can purge orders but still track serial 
numbers. You should only purge this file if you do 
not want to track serial numbers for older sales. If 
you want to track the sale of a serial number at a later
time, do not purge this file. To print the contents of
this file, select Serial Numbers from the Customer 
Service menu.
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Accounts Receivable Open Invoices DacEasy Order Entry stores the open invoices even 
after they are paid. You may want to purge the older,
paid open invoices after they no longer apply to your
reports. When purging the AR open invoices, a list 
of open invoices appears so you can select the 
invoices you want to delete. 

If you are running DacEasy Order Entry interfaced 
with DacEasy Accounting, you cannot use the Purge
routine on AR open invoices. You must run the 
Receivables Period End routine in DacEasy 
Accounting to clear the open invoices from the 
Aging report and statements.

Promotional Prices This file contains the transactions entered using the
Edit Promotional Price dialog box. Use the Purge 
routine to delete old promotions you do not need 
anymore. To print the contents of this file, select 
Promotional Price from the Reports menu.

Customer Transaction History If you select the Track Customer Transaction 
History check box on the System Preferences dialog
box, an entry is recorded in this file each time you 
enter transactions for open invoice customers. To 
view the customer transaction history for a 
customer, select Customers from the Edit menu. 
Enter a customer and click Transactions. Purging 
this file removes all customer historical transaction 
detail within the date range specified. 

Assembly Transactions Purging this file removes all posted or deleted 
assembly transactions within the date range entered.
This option purges transactions entered using the 
Assembly on-the-fly routine from Order Entry 
dialog box in DacEasy Order Entry and using the 
Assembly Transaction dialog box in DacEasy 
Accounting (if interfaced).

Product History Detail If you selected to track product transaction history 
on the System Preferences dialog box, an entry is 
made to this file every time you enter transactions 
using a product. To view the product history detail,
select Products from the Edit menu. Enter a 
product. Click Options, and then select Product 
History Detail. Purging this file removes all product
history detail within the date range specified.

Customers You can purge a range of customers based on the 
Last Sales Date field on the Edit Customer dialog 
box. All customers meeting the requirements are 
deleted from the system.
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Products You can purge a range of products based on the Last
Sales Date field on the Edit Products dialog box. All
products meeting the requirements are deleted from
the system.

Services You can purge a range of services based on the Last
Sales Date field on the Edit Service dialog box. All 
services meeting the requirements are deleted from
the system.
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To Purge a File

1 Make a backup of your order entry data files. Archive this backup and keep 
it as a record of the information you are going to purge. If you are running 
DacEasy Order Entry interfaced with DacEasy Accounting, make a separate 
backup of your accounting data files.

It is very important that you have a current backup before purging files. The 
purge process cannot be reversed. If you are running DacEasy Order Entry 
interfaced with DacEasy Accounting, make a separate backup of your 
accounting data files or perform the Backup routine from the Business Center 
to back up all data files in your company profile.

2 Select Purge from the Periodic menu. The Purge Files dialog box appears.

3 Select the file you want to purge. 

4 Type the last sales date or range of dates for the information you want 
purged from the data files. 

5 Click OK. The Purge routine begins. 

If you selected to purge the AR Open Invoice file and you are not running 
DacEasy Order Entry interfaced with DacEasy Accounting, a list of open 
invoices appears. Select the open invoices you want to purge and click 
OK. The Purge routine begins.

Run the Recover routine on your data files after you run the Purge routine. 
The Recover routine compresses your files and frees up hard disk space 
especially after the Purge routine. Select Utilities from the File menu to 
access the Recover routine.

Note

Note
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Point of Sale Year End Procedures

The Year End routine updates the historical information in your Customer, 
Product, Service, Salespeople, and Tax modules. DacEasy transfers the year-to-
date (YTD) values to the last year (LY) field and last year values to year before last 
(YBL). Values in the Year Before Last fields are removed during the Year End 
routine. The routine also changes the period dates to the new year.
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Running the AR End of Period Routine

When you run the Accounts Receivable (AR) End of Period routine, your paid, 
posted Accounts Receivable (AR) transactions are cleared from the current 
company. This keeps your customer data at a minimum. If you run this routine 
periodically, the open invoice section of the AR payments dialog box is not 
cluttered with old, paid invoices. It is important that you make a backup of your 
data prior to running this routine because it cannot be reversed.

The Accounts Receivable Period End routine does the following:

• Removes all paid-in-full invoices from the Accounts Receivable Open 
Invoice files. This information appears when entering AR payments. The 
invoices must be posted and dated on or before the date the Period End 
routine is run.

• Updates the Balance Information for your customers. This Period is 
cleared and the amount is added to the Beginning field.

• For balance forward-type customers, all remaining posted transactions 
for the period are consolidated into one invoice. The date becomes the 
invoice number, using the YYYYMMDD.

If you are running DacEasy Point of Sale interfaced with DacEasy Accounting, run 
the Accounts Receivable Period End routine in DacEasy Accounting.

To Run the Accounts Receivable Period End Routine

1 Select AR End of Period from the Periodic menu. The Accounts Receivable 
Period End dialog box appears.

2 Enter a date corresponding to the period you want to close. The posted, paid 
invoices on or before the date entered clear from the system. The period that 
corresponds to the date appears in the Period field.

3 Click OK to begin AR Period End routine.

4 Click Continue to return to the main menu.

Note
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Closing the Year

The Year End routine updates the historical information in your Customer, 
Product, Service, Salespeople, and Tax modules. DacEasy transfers the year-to-
date (YTD) values to the last year (LY) field and last year values to year before last 
(YBL). Values in the Year Before Last fields are removed during the Year End 
routine. The routine also changes the period dates to the new year.

Performing the Year End routine in DacEasy Point of Sale is almost the same 
procedure as the Year End routine in DacEasy Accounting. If you are running 
DacEasy Point of Sale interfaced with DacEasy Accounting, you are not required 
to perform the Year End routine in DacEasy Point of Sale. Instead, run the Year 
End routine in DacEasy Accounting.

As mentioned earlier, the information for the year before last is removed during 
the Year End routine. If you want to retain this historical information for your 
customers, products, and services, make a backup of your data files before 
performing the Year End routine. Store the backup for archival purposes.

If you are not running DacEasy Point of Sale interfaced with DacEasy Accounting, 
the Year End routine updates the historical information for customer, product, 
service, and tax files. It also clears the Sales and Commission information in the 
Salesperson file.
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To Run the Year End Routine 
1 Post all sales transactions in DacEasy Point of Sale. For steps on posting, refer to 

the chapter titled “Daily Register Processing” in the DacEasy Point of Sale User’s 
Guide.

The easiest way to verify that all sales transactions are posted is to run a Sales 
Listing report in DacEasy Point of Sale from first to last. Select Journals from the 
Process menu. Select to print a Listing. If no asterisks appear next to the 
transaction number, all transactions are posted.

2 Make a backup of your data files. Clearly label each disk.

3 Select Year End from the Periodic menu. The current year closed during this 
procedure appears on the Year End dialog box. Verify that the year is the one 
you want to close. 

If the year you want to close does not correspond with the year that appears, 
exit the dialog box and change the system date. Then, return to the Year End 
dialog box.

If the year that appears is correct, select Yes to continue.

4 Click Start Year End Close. A message appears when the process is complete.

An error appears if all transactions are not posted. Exit this function and post all 
transactions before closing the year.

5 Click Continue to return to the main menu.

Note

Note
68



Purging Data Files
File Descriptions

 

 

 

 

Purging Data Files

Use the Purge routine to remove unwanted information from your data files. 
If you purge a transaction file, DacEasy removes all posted and deleted 
transactions from the file for the specified date range. In addition, you can 
purge customers, products, and services that you no longer need. 

After you purge your transaction files, you can no longer view the purged 
transactions or print listing reports including the purged transactions. For 
this reason, you might choose not to purge data until after you close the year. 
It is very important that you back up your data files prior to purging 
information. Once the data has been purged, it can only be retrieved by 
restoring a backup made prior to running the Purge routine.

To increase available hard disk space, run the Recover routine on the file after 
you perform the Purge routine. 

File Descriptions

A brief explanation of the data contained in each file follows. Review the list 
to determine which files you need to purge and which files you need to keep 
information for reporting purposes.

General Ledger This file holds all general ledger transactions created
when DacEasy Point of Sale is not interfaced with 
DacEasy Accounting. DacEasy Point of Sale assigns
its own account numbers to the transactions in the 
General Ledger file. To print a listing of general 
ledger transactions, select General Ledger from the 
Reports menu.

If you are running DacEasy Point of Sale interfaced
with DacEasy Accounting, Point of Sale uses the 
General Ledger files in Accounting. So, to purge the
general ledger transactions with the POS journal 
code you must access the DacEasy Accounting 
program and run the Purge routine on the General 
Ledger transaction files there.
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Sales Transactions This file contains detail information for all sales 
entered in the program. Point of Sale maintains sales
detail in this file, even after you post sales 
transactions. To print the transactions in this file, 
print a Sales Listing report by selecting Journals 
from the Process menu. Purging sales transactions 
also purges the Credit Card file. This file is used for
the AutoOrder and AutoReorder feature. If you 
would like to retain your customer’s sales history for
this feature, do not purge this file.

Layaway Records This file contains all the information for your 
layaway transactions. Each time you enter a layaway
transaction or make a payment to a layaway this file
is updated. To print the information held in this file
select Layaway Transactions from the Reports 
menu.

Serial Numbers Point of Sale tracks serial numbers for your products
and services after a sale. DacEasy stores serial 
number information in a separate file from the sales
so you can purge sales transactions but still track 
serial numbers. You should only purge this file if you
do not want to track serial numbers for older sales. 
If you want to track the sale of a serial number at a 
later time, do not purge this file. To print the 
contents of this file, select Serial Number Tracking 
from the Reports menu.

Product History Purging this file removes all product history from 
the product inquiry within the date range specified.
To view the product historical inquiry information,
select Product Inquiry from the Options menu. 

Customer History Purging this file removes all customer history from 
the customer inquiry within the date range specified.
To view the customer historical inquiry 
information, select Customer Inquiry from the 
Options menu. 

Service History Purging this file removes all service history from the
service inquiry within the date range specified. To 
view the service historical inquiry information, 
select Service Inquiry from the Options menu. 

 Quotes This file contains the detail of all sales quotes in the
company. Use the Purge routine to delete old quotes
you do not need anymore. To view all the quotes in
the company, click Options, and then select Quotes
from the Sales Register Entry dialog box.
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 Promotional Prices This file contains the transactions entered using the
Edit Promotional Price dialog box. Use the Purge 
routine to delete old promotions you do not need 
anymore.

Customer Transaction History If you chose to track customer transaction history 
on the System Preferences dialog box, an entry is 
made to this file every time you enter transactions 
for open invoice customers. To view the customer 
transaction history for a customer, select Customers
from the Edit menu. Enter a customer and click 
Transactions. Purging this file removes all customer
historical transaction detail within the date range 
specified. 

Salesperson Timesheets This file contains the times each salesperson logged
in and out of the sales register. To view the 
timesheets for each salesperson, select Tables from 
the Edit menu, and then select Salesperson 
Timesheet.

Assembly Transactions Purging this file removes all posted or deleted 
assembly transactions within the date range entered.
This option purges transactions entered using the 
Assembly Transaction dialog box in DacEasy 
Accounting and the Sales Register Entry dialog box
using Assembly on-the-fly routine.

Product History Detail If you chose to track product transaction history on
the System Preferences dialog box, an entry is made
to this file every time you enter transactions using a
product. To view the product history detail, select 
Products from the Edit menu. Enter a product. 
Click Options, and then select Product History 
Detail. Purging this file removes all product history
detail within the date range specified.

Customers You can purge a range of customers based on the 
Last Sales Date field on the Edit Customer dialog 
box. All customers that meet the requirements are 
deleted from the system.

Products You can purge a range of products based on the Last
Sales Date field on the Edit Products dialog box. All
products that meet the requirements are deleted 
from the system.
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Services You can purge a range of services based on the Last
Sales Date field on the Edit Service dialog box. All 
services that meet the requirements are deleted from
the system.
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To Purge Files
File Descriptions
To Purge Files
1 .Select Purge from the Periodic menu. The Purge Files dialog box 

appears.

It is very important that you have a current backup before purging files. The 
purge process cannot be reversed. If you are running DacEasy Point of Sale 
interfaced with DacEasy Accounting, make a separate backup of your 
accounting data files or perform the Backup routine from the Business Center 
to back up all data files in your company profile.

2 Select the file to purge.

3 If a transaction file is selected, enter the range of transactions to purge 
based on the transaction date. All records up to and including the date 
entered are purged.

If a non-transaction file is selected, enter the ending date for the last 
record to purge. All records up to and including the date entered are 
purged.

4 Click OK. A confirmation message appears when the purge process is 
complete.

5 Click Continue to return to the Purge Files dialog box.

Note
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